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Chapter 1. Introduction to Process Manager

This section describes each of the component applications that make up the Process
Manager software, and introduces each of the work items used to define and
schedule your workload.

About Process Manager

Process Manager comprises three client applications and a server application. The
client applications are:

* Process Manager Designer:
— The Flow Editor
— The Calendar Editor

* The Flow Manager

The Process Manager Server is the scheduling interface between the client
applications and the execution agent, Process Manager.

Tip:

Flow Editor may not be installed if you purchased the Platform Suite for SAS. For
more information, contact your sales representative.

The Flow Editor

You use the Flow Editor to define your flow definitions: the jobs and their
relationships with other jobs in the flow, any dependencies they have on files, and
any time dependencies they may have. You also use the Flow Editor to submit
your flow definitions—this places them under the control of Process Manager.

You can submit a flow definition in three ways:

* By submitting it to be triggered when one or more events occur

¢ By submitting it to be triggered manually

* By running it immediately
After a flow definition is submitted, a copy of the definition resides in Process
Manager. If the flow definition is to be triggered by an event, Process Manager
triggers it automatically when that event occurs, creating a flow. If the flow
definition is to be triggered manually, the flow definition waits in Process
Manager until you trigger it, creating a flow. If the flow definition is run

immediately, Process Manager does not store a copy of the definition—just the
flow.

Using the Flow Editor, you can work with existing flow definitions, easily
modifying them to create new ones. You can also create reusable flow definitions
that can be shared by many users, or reused over and over again. These flow
definitions can be easily incorporated into a new definition as subflows. These
techniques allow you to create intricate work flows quickly, with fewer errors.

You start the Flow Editor from the Windows start menu, by selecting IBM
Corporation> Platform Process Manager > Flow Editor, or by running
floweditor on UNIX.
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The Calendar Editor

You use the Calendar Editor to define calendars, which Process Manager uses to
calculate the dates on which a job or flow should run. Calendars contain either
specific dates or expressions that resolve to a series of dates.

Process Manager calendars are independent of jobs, flow definitions and flows, so
that they can be reused. The Process Manager administrator can create calendars
that can be used by any user of Process Manager. These are referred to as system
calendars. Process Manager includes a number of built-in system calendars so you
do not need to define some of the more commonly used expressions.

Once a calendar is defined, you associate a job or a flow definition with the
calendar using a time event.

You start the Calendar Editor from the Windows start menu, by selecting IBM
Corporation > Platform Process Manager > Calendar Editor, or by running
caleditor on UNIX.

The Flow Manager

You use the Flow Manager to trigger, monitor and control running flows, and to
obtain history information about completed flows.

Using the Flow Manager, you can view the status of, suspend, or kill a flow. While
working within the Flow Manager, you can review the flow definition, while
comparing it to the running flow.

You start the Flow Manager from the Windows start menu, by selecting IBM
Corporation > Platform Process Manager > Flow Manager, or by running
flowmanager on UNIX.

About Process Manager terms
Jobs

-
1‘_1

A job is a program or command that is scheduled to run in a specific environment.
A job can have many attributes specifying its scheduling and execution
requirements. You specify the attributes of the job when you define the job in the
Flow Editor. Process Manager schedules and manages jobs that run on Process
Manager hosts. Process Manager uses job attributes, system resource information,
and configuration settings to decide when, where, and how to run jobs. While each
job is assigned a unique job name by the system, you can associate your own job
names to make referencing easier.

Dependencies
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A dependency describes the order in which something happens within a flow: a job
(or job array or subflow) can depend on the completion of a job, job array, subflow,
or event before it can run.

A dependency is shown in the Flow Editor and Flow Manager as a line with an
arrow. The job at the tip of the arrow cannot run until the work item at the other
end of the arrow reaches a particular condition.

A dependency is used to indicate relationships between jobs, events, alarms, and
SO on.

Job dependencies

A job dependency is a dependency that a job (or job array or subflow) has on the
completion of a predecessor job. You can define a dependency that controls a job’s
execution upon the completion, failure, or startup of other jobs. You can also start a
job when the predecessor fails with a specific exit code, or experiences a specific
exception.

Job dependencies are shown in the Flow Editor and Flow Manager as a line with
an arrow. The job at the tip of the arrow cannot run until its predecessor at the
other end of the arrow reaches a particular condition. The default type of job
dependency is on the successful completion of the predecessor.

Job arrays

3

A job array is a group of homogeneous jobs—jobs that share the same executable
and resource requirements, but have different input files, for example inputl,
input2, input3 and so on. You can use a job array to submit, control and monitor
all of the jobs as a single unit. Each job submitted from a job array shares the same
job ID as the job array and is uniquely referenced using an array index. The
dimension and structure of a job array is defined when the job array is created.

Job submission script

e

A job submission script is a shell script or a batch file, which you can define to
submit a job. You can define and submit customized job array submission script
with bsub command and options. You can monitor and control the jobs that have
been submitted through the customized job submission scripts. You specify the
attributes of the script when you define the job submission script in the Flow
Editor. Process Manager schedules and manages job submission scripts that run on
the Process Manager hosts.

Job array submission script
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A job array submission script is a group of submission scripts— that share the same
executable and resource requirements, but have different input files, for example
scriptl, script2, script3, and so on. You can use a customized job array
submission script to control and monitor all the jobs and job arrays. Each job
submitted from a job array submission script shares the same job ID as the job
array submission script and is uniquely referenced using an array index. The
dimension and structure of a job array submission script is defined when the job
array submission script is created.

Manual jobs

4

A manual job is a place-holder in a flow—it marks the place in a process where
some manual activity must take place before the flow can continue. Successors of a
manual job cannot run until the manual job is explicitly completed.

Local jobs

i

A local job is a job that will execute immediately on the Process Manager host
without going through LSF®. A local job is usually a short and small job.

It is not recommended to run long, computational-intensive or data-intensive local
jobs as it can overload the Process Manager host.

Other Batch jobs

An Other Batch job is a job that you run on a remote batch system or workload
manager that is not LSE.

When Process Manager is configured to communicate with another batch system,
you will see the Other Batch Job work item enabled in Flow Editor:

In the Job Definition, you specify the command to run, other job submission
options, and the user account under which the job is to run in the Other Batch
System.
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Flow definitions

A flow definition is a container for a group of related jobs. The flow definition
describes both the jobs and their relationships to each other, as well as any
dependencies the jobs have on files or dates and times. Using a flow definition,
you can create a complex schedule involving many jobs, and manipulate it as a
single entity. You can also use a flow definition to group jobs together that form a
particular function, and imbed the flow definition as a subflow within a larger
flow definition. This allows you to share and reuse common functions.

Flow definitions can be stored locally on your own machine, or within a shared file
system. You can see and import flow definitions created by another user, but you
cannot control running flows owned by another user unless you have
administrative authority.

Flows

A flow is the particular occurrence of a flow definition that is created when the
flow definition is triggered. When Process Manager creates a flow from the flow
definition, it assigns each occurrence of the flow a unique ID called the flow ID.

Adhoc flows

An adhoc flow is a flow that is run directly by the Process Manager Server without
the server saving a copy of the flow definition. An adhoc flow is run directly from
the Flow Editor.

An adhoc flow is displayed in the tree view of the Flow Manager in each of the
following ways:

¢ In the By Definition view, in a folder called adhoc
* In the By Event view, in a folder called adhoc

Static subflows

A static subflow is a flow definition that has been copied into another flow
definition. Using a static subflow within a flow is a simple method to share and
reuse common routines.

Dynamic subflows

A dynamic subflow is a reference to another flow definition. The flow definition that
is referenced is called a target flow. The flow that contains the dynamic subflow is
called the parent flow.

You maintain the target flow separately from the parent flow. Changes made to the
target flow are automatically updated in the parent flow.
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Only target flows that have been submitted to Process Manager and published can
be selected in a dynamic subflow.

Static flow array

A static flow array is a way to specify to run a static subflow as an array. The
subflow will run as many times as the size of the array.

In addition, in the array attributes, you can define whether to run the subflow in
parallel or sequentially.

Dynamic flow array

A dynamic flow array is a way to specify to run a dynamic subflow as an array. The
subflow will run as many times as the size of the array.

In addition, in the array attributes, you can define whether to run the subflow in
parallel or sequentially.

You maintain the target flow separately from the parent flow. Changes made to the
target flow are automatically updated in the parent flow.

Only target flows that have been submitted to Process Manager and published can
be selected for the dynamic flow array.

Events

An event is a change or occurrence in the system (such as the creation of a specific
file, a prior job completing with a particular exit code, or simply the arrival of a
file at a particular date and time) that can be used to trigger a flow or one or more
jobs within a flow. Process Manager responds to the following types of events:

* Time events—points of time (defined by calendars and time expressions) that
can be used to trigger the scheduling of jobs

* File events—changes in a file’s status

* Proxy events—events used to represent another flow or a work item that runs
within another flow

* Link events—events used to consolidate the output of other events

Time events
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You use time events in Process Manager to make something happen at a specific
time. You can use a time event to specify the frequency at which a repetitive job
repeats, to prevent a job from running until a particular time, or to specify when to
start running a flow.

You cannot create a time event without referencing a calendar, which provides the
date or dates on which the time event is valid, allowing it to trigger.

You create time events using the Flow Editor.

File events

0L
01010
01010

You use file events to make something happen when a file reaches a particular state.
You can use a file event to trigger a flow, job or subflow: when a file arrives; when
a file reaches a certain size; if a certain file exists; or any combination of these
conditions.

You create file events using the Flow Editor.

Proxy events

You use proxy events to represent work items that run within another flow, or to
represent another flow. You can create a dependency on the success or failure of a
proxy event. You can use a proxy event to trigger a flow, or to trigger a work item
within a flow.

Link events

You use link events to combine multiple dependencies into a single point in a flow
diagram. You can use link events to run a job when multiple jobs complete, or you
can use them to run a subflow when one of a group of jobs complete. For example,
you can use an AND link event to trigger a job when all of a group of conditions
are met, or you can use an OR link event to trigger a job when any one or more of
a group of conditions is met.

You create link events using the Flow Editor.
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Calendars

A calendar consists of a sequence of days on which the calendar is considered valid.
A job is scheduled when the calendar is valid and a time of day specification is
met. Calendars are defined and manipulated independently of jobs so that multiple
jobs and flows can share the same calendar. Each user can maintain a private set of
calendars, or use the calendars defined as system calendars. If a calendar is
changed, any jobs associated with the calendar will automatically run according to
the new definition. Calendars are stored within Process Manager’s private storage,
and cannot be stored locally or edited outside of the Calendar Editor.

Exceptions

An exception is a specific error condition that is detected when a job does not
process as expected. Process Manager detects several of these conditions.

Exception Handlers

An exception handler is a function used to respond when an exception occurs. You
can use jobs or flows as exception handlers, or you can use Process Manager’s
built-in exception handlers:

* Kill
* Rerun

¢ Alarms
Kill

You can automatically kill a job, flow, or subflow if it experiences the specified
exception.

Rerun

You can automatically rerun a job, flow, or subflow if it experiences the specified
exception.

Alarms

An alarm is a type of built-in exception handler, used to send an email notification
to key personnel or execute a script to show that an error has occurred that
requires intervention.

Variables

You can use Process Manager to pass variables to and from scripts. Process
Manager supports three kinds of variables:

* Local variables, that allow you to set a value of a variable and have the value
available within a flow;

* Global variables, that allow you to set a value of a variable and have the value
available anywhere within the Process Manager Server.
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* Environment variables, that allow you to submit a job with an environment
variable, including a user or local variable.

Variable evaluator

Vi

The variable evaluator (VE) is a work item in the flow editor that allows jobs to
depend on the evaluation of variable expressions instead of the traditional job exit
status, time events, and file events.

This work item contains no actual jobs to run, and therefore you cannot kill,
suspend, or resume it. In addition, since the work item does not perform any
actual work, you cannot use the variable evaluator as a triggering event, a proxy
event to start the next work item, or as a flow completion criterion.

The variable evaluator serves as an intermediate step between jobs and the
validation of variable decision branches. Typically, the predecessors of a variable
evaluator assign values to various user variables. When all the variables are set,
the variable evaluator will evaluate all of its variable expression branches and
determine which successors to start executing. If there is no predecessor to the
variable evaluator, the variable evaluator will start and run to completion
immediately.

File naming conventions
This guide uses UNIX file naming conventions to illustrate file names. However, if

the file you are referencing is on a Windows file system, use Windows file naming
conventions where applicable.

Change your server

You can change the server you are using in any of the three client applications
(Flow Editor, Flow Manager, and Calendar Editor).

Changing the server affects only the current session of the client application. The
next time you open the client application, the server defined in js.conf is still
used.

1. In any of the client applications, select File > Change Server.

File Edit View Inset Action Window Help
Hew Ctrleh
Open ChrkD
Close
Save Chrl+5
Save s
Save Al

Page Setup..
Print Optians.
Fiint Preview
Print CHi+P

1 C:\Documen sEnmgs\mgs\anjusn anl

2 C:\Documen...s and Settingshihepsh
Exit

The Change Server dialog opens.

Chapter 1. Introduction to Process Manager 9



£ Change Server X

Connect b0 new server

Hosk name: | localhost -
(short or fully-Guslifisd name)

Port: | 1966] -
e

2. Specify the host name and port for the new server. Use the drop down list to
select from any host names or ports that you have specified before.
3. Click OK.

The client application connects to the new server. You may be asked for your
username and password. If the connection fails, the previous server is used
instead.

4. Check you server host name and port number in the lower left hand corner of
your client application. In Flow Manager, status is also available.

Server. localhost 1966 Status: On

You have changed your server.

About flow definitions and flows

A flow definition is a collection of Process Manager work items (jobs, job arrays
and subflows) and their relationships. These Process Manager work items are
defined graphically in the Flow Editor, where the relationships between the work
items—any dependencies they may have on each other—are also represented
graphically. The following picture illustrates a flow definition that consists of two
jobs (J1 and J2) a job array (Al) and an imbedded subflow (recovery):
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& Process Manager: Flow Editor B -0
File Edit View Insert Action Window Help
Rl TR

g@m@n&aw

In the above flow definition, J1 must complete before ]2 and Al can run. If ]2 fails,
the subflow recovery runs.

Actions you can perform against flow definitions

The following terms have specific meanings within the Process Manager context:
Publish

The term publish is used to describe the act of enabling a target flow to become
available to dynamic subflows and flow arrays.

Unpublish

The term unpublish is used to describe the act of removing a target flow from the
list of target flows available to dynamic subflows and flow arrays. The target flow
is no longer available to dynamic subflows and flow arrays.

Hold

The term hold is used to describe the act of preventing Process Manager from
running a flow, even though the flow definition has been submitted to Process
Manager and is recognized by Process Manager. Holding a flow definition
essentially causes Process Manager to ignore that definition until such time as it is
released or explicitly triggered.

Release

The term release is used to describe the act of requesting that Process Manager
once again manage a flow definition—to release a flow definition that is on hold.
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Trigger

The term trigger is used to describe the act of initiating the running of a flow.
When a flow definition is triggered, a flow is created.

Remove

The term remove is used to describe the act of removing a flow definition from the
Process Manager system. After a flow definition is removed, Process Manager no
longer knows about it and cannot schedule any new occurrences of the flow.

What can | do with a flow definition?

e Submit and run the flow immediately, where the definition of the flow is not
stored in the Process Manager system. Process Manager is only aware of the
specific, adhoc occurrence of the flow.

e Submit a flow definition to be triggered manually at a later time.
* Submit a flow definition to run on a recurring basis, on a particular schedule.
* Submit a flow definition to run when a file reaches a particular state.

* Define specific routines as individual flow definitions, so that each can be reused
like a subroutine within other flow definitions.

* Set exit conditions on a flow definition that contains multiple branches, so that
completion of any single branch constitutes completion of the flow, or require
that all branches complete before the flow is complete.

¢ Imbed a flow definition as a subflow within another flow definition.

* Use a flow to handle an exception in another flow.

What can | do with a flow?
* Kill, suspend, or resume an entire flow

* Rerun a failed flow, starting at the first job that failed in each path through the
flow or from any rerun starting points that you set in the flow

* Rerun a flow while a job is still running, or rerun a flow that is done, starting at
the first job that failed in each path through the flow or from any rerun starting
points that you set in the flow

What can | do with a job?

* Kill a running job or a local job
* Hold a waiting job in a running flow
* Rerun a Running, Exit, or Done job in a completed flow

 Force a job complete in a completed flow

Where do | store my flow definitions?

You can store your flow definitions locally on your own computer, or you can
store them on a shared file system. If other users will be creating similar flow
definitions, you can create flow definitions that perform common routines so that
you can share them with other users.

What makes a flow Done?

Unless you specify otherwise by defining an exit condition for the flow, Process
Manager follows this default behavior:
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* A flow is considered successful with a status of Done only when all jobs in the
flow complete successfully.

* A flow is considered to have failed with a status of Exit if any job in the flow
fails.

What happens if a job exits?

Under the default behavior, if a job in a flow exits, no additional jobs in the flow
are dispatched, although any currently running jobs will continue running until
they complete. If you do not want the flow to exit if a job fails, you must specify
an exit condition for the flow and handle the exit condition explicitly.

How does Process Manager know when my flow is complete?

A large flow may diverge into multiple branches, depending on the design of your
workflow. For example, job 1 may release multiple jobs, each of which has a string
of successors. In some cases, you may want every work item in the flow to
complete successfully before the flow is considered complete, and each branch of
the flow must complete. This is the default behavior.

In other cases, your flow may include error recovery routines that only run under
certain conditions. In those cases, you do not expect every job or path in the flow
to complete. Process Manager allows you to specify a completion attribute, which
defines what constitutes completion of the flow. For example, you can specify that
only one of many paths must complete.

Flow definition

examples

To help you build your own flows, you can refer to the examples installed with
Flow Editor. You can access the examples through Help > Flow Examples:

e Sample.xml: Demonstrates a simple flow with three jobs and the dependency
Completes successfully.

* jobs_and_dependencies.xml: Demonstrates a flow with three separate branches
that run according to whether the first job in the flow completed successfully or
ended with a specific exit code or exit codes.

* event_and_alarm.xml: Demonstrates how to use time of day and arrival of a file
in a specific directory to trigger a subflow. Also uses an alarm to send an email
to the administrator.

* dynamic_flow.xml, target_flow.xml: Demonstrates how to use a subflow by
reference, how to pass input variables from a main flow to a subflow, and how
to pass a variable from a subflow to the parent flow and use it in a subsequent
job in the main flow.

e flowarray_eval.xml: Demonstrates how to use the variable evaluator to decide
which branch of a flow to run, how to run flow arrays in parallel or sequentially,
and how to use a variable to set the array size. This flow contains two subflows
to be run as arrays, and a condition evaluator that decides whether to run the
arrays in parallel or sequentially.
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Chapter 2. Process Manager Calendars

Process Manager uses calendars to define the dates in a time event, which can be
used to determine when a job runs or a flow triggers. Calendars are defined
independently of jobs and flows so that they can be associated with multiple
events.

Process Manager uses calendars to create time events to initiate an action at a
particular date and time. The time event consists of the date and time to trigger
the event, and the duration in which the event is valid. The calendar provides the
date specification for the time event.

You create Process Manager calendars using the Calendar Editor.
About calendars

Process Manager uses three types of calendars:
* Those that consist of one or more specific dates
¢ Those that consist of an expression that resolves to a series of dates

* Those that combine other calendars to create complex expressions that resolve to
a series of dates. These calendars can use logical operations within the calendar
definition.

Each type of calendar definition can resolve to one or more dates.
About system calendars

System calendars are calendars that are predefined or created by your Process
Manager administrator. These calendars are owned by the virtual user “Sys” and
can be referenced by any user. Only the Process Manager administrator can create
or delete system calendars.

Process Manager includes a number of predefined system calendars that you can
use without having to define them. In addition to the following list, your Process
Manager administrator may define other system calendars for your use. The
following is a list of the system calendars that are ready for your use:
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Types of Calendars Calendar Names

Weekly calendars Mondays
Tuesdays
Wednesdays
Thursdays
Fridays
Saturdays
Sundays
Daily
Weekdays
Weekends

Businessdays

Monthly calendars First_monday_of_month
First_tuesday_of_month
First_wednesday_of_month
First_thursday_of_month
First_friday_of _month
First_saturday_of_month
First_sunday_of_month
First_weekday_of_month
Last_weekday_of_month
First_businessday_of_month
Last_businessday_of_month

Biweekly_pay_days

Yearly calendars Holidays *
First_day_of_year
Last_day_of_year
First_businessday_of_year
Last_businessday_of_year
First_weekday_of_year

Last_weekday_of_year

*The Holidays calendar is predefined with Process Manager. However, it must be edited by a Process Manager
administrator to update the holidays for your company for each year.
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About the calendar editor

You use the Calendar Editor to create calendars that define the dates on which you
want some action to take place. Calendars are required to create time events to
trigger flows or dispatch jobs at a particular time. The 6 Server must be running
before you can use the Calendar Editor.

About the Calendar Editor user interface

The Calendar Editor is divided into two panes:
* The list of calendars in the left-hand pane
¢ The calendar definition in the right-hand pane

When you create a new calendar, you define the calendar in the right-hand
pane. When you save the calendar, it appears in the list of calendars, under your
user ID in the left-hand pane.

% Process Manager: Calendar Editor

Calendar View Window Help

- || |

Calendars Y

= ' =) x]
EH) Svs

Biweekly_pay_days

Businessdays Every nonday
Daily Description:

First_businessday_of_month
First_businessday_of_year Humeie B
First_day_of_year
First_friday_of_month ~This Happens. ..

First_mondsy_of_month -
: = Dl Every [0 | 2] weehte) o

o month 1% Weekly & The Following day(s)
First_tuesday_of_manth

First_wednesday_of month Ll sy [ wow N S [
First_weskday_of_manth e

First_weekday_of_year i o the [frst =] of the [Bieekly_pay_davs@ays =
Fridays

Holidays

Last_businessday_of_month
Last_businessday_of _ysar
Last_day_of_ysar
Last_weskday_of_month

Last_weskday_of vear -
Hondays q | »

Saturdays

i Duration
Thursdays errectiv=s. [1ant =] [0 S [ane. =] ol [aer (=] T2 = [0z =]
Tuesdays

Wednesdays
Weskdays
Weskends
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About the toolbar

The Calendar Editor toolbar looks like this:

Create a new calendar
Open a calendar
Delete a calendar
Save the calendar

View dates the calendar resolves to
g ’— Refrash the list of calendars
B SES| e

About calendar names

When you create a calendar, you need to save it with a unique name. Some rules

apply:

* Calendar names can contain the digits 0 to 9, the characters a to z and A to Z,
underscore (_), and dash (-)

¢ Calendar names cannot begin with a number
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Create a calendar with specific dates
About this task

Use this method to create a calendar when:
* The calendar needs to be valid for only one or two dates

* The calendar needs to be valid for specific, random dates that do not repeat with
any pattern

Procedure
1. Ensure that Process Manager is running, and open the Calendar Editor.

2. From the Calendar menu, select New Calendar, and select Clicking on Date(s).
The date selection dialog box appears. The dialog box is shown here with the
list of calendars expanded on the left.

a3 s

£2 Process Manager: Calendar Editor [} | =]

Calendar Wiew Window Help

EREEEEE

Calendars = T

: I %8 Document1 =%

1 ) Owners e -

85 5 slendar Description
Biweekly_pay_days
Businessdays pay days
Daly Description:
First_businessday_of_month
First_businessday_of _year Wi el
First_day _of year
First_friday_of_month (January, 2012 [February, 2012 March, 2012
::::*:";ru":j:;°hm°nth SUN MOM TUE WED THU FRT SAT | |SUM MON TUE WED THU FRI SAT | |SUN MON TUE WED THU FRT SAT
et L o2 3 4 5 6 T oz % 4 t o2 3
First_thursday of month
S umecst S ookl B 9 10 11 12 13 14 5 6 7 8 9 10 1 4 5 6 7 8 9 10
First_wednesday_of_month 15 16 17 18 19 20 2t 1z 13 14 15 16 17 18 |l 11 12 13 1 15 16 17
First_weekday_of month
it iweakilsy ofivear 22 23 24 25 25 22 2 Wl 19 20 21 oz 23 24 2 llie 15 20 2 o2 23
Fiidays 23 30 3t % 27 | 2 25 26 27 8 23 3 8L
Holidays
Last_businessday_of_manth
Last_businessday_of_year
R ~aprl, 2012 May, 2012 June, 2012
Last_weskday_of_month SUN MON TUE WED THU FRI SAT | |SUM MON TUE WED THU FRI SAT | |SUN MON TUE WED THU FRI SAT
Last_weskday_of_year
Mondays 123557 1 2 3 4 s 12
oatldege 8 9 10 11 12 13 14 6 7 8 9 1m0 11 12 3 4 5 & 7 8 9
Sundays
Thursdays 15 16 17 18 19 20 21 13 14 15 16 17 18 19 [[ 10 11 12 13 14 15 16
Tesdays 22 23 24 25 = 2z . 20 7 2z 23 oz 26 17 18 19 2 2 2 23
wednesdays
weekdays 28 0 27 28 29 3 3 24 25 26 27 28 28
weekends

Backward Forward

Server: ib0Sb01.Isf platform.com: 3498

3. In the Description field, specify a description for the calendar that makes it
obvious when this calendar is valid. This description is very useful: it is
displayed in the fly-over text when you point to a calendar name in the list,
and helps you quickly determine which calendar you want to use.

4. Select the dates on which you want this calendar to be valid by left-clicking on
each date. You cannot select dates in the past.

5. When you have finished selecting dates, save the calendar: from the Calendar
menu, select Save Calendar. When prompted, specify a meaningful name for
the calendar. Click Save. The calendar is added to the list of centrally stored
calendars, under your user name.

Create a calendar using an expression
About this task

Use this method to create a calendar when:
* The calendar needs to be valid every nth day, week, month or year
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¢ The calendar needs to be valid for the same dates every year

* The calendar needs to be valid for the same dates every month

* The calendar needs to be valid for the same days of the week every week

Pro

cedure

1. Open the Calendar Editor.

2. From the Calendar menu, select New Calendar and select Specify Pattern. The
calendar expression dialog box appears. The dialog box is shown here with the

list of calendars expanded on the left.

.. Holidays

.. Last_businessday_of_month
..Last_businessday_of_year
..Last_day_of _year

.. Last_weekday_of _month
.. Last_weekday_of _year

.. Mondays

.. 5aturdays

.. Sundays

.. Thursdays

.. Tuesdays

. Wednesdays

.. Weekdays

Server: ibof

.. Weekends

ISh01 . Isf.platform.com: 3495

o -
% Process Manager: Calendar Editor _ ol x|
Calendar View Window Help
@
Calendars ]
——— i & Document2 I =2 X|
-0 Sve ~Calendar Description

. Bimeekly_pay_days

. Businessdays

' Daly Description:

. First_businessday_of_menth

First_businessday_of_year Owner:  clotito
~This Happens. .. ekl
C Daly Every [ 1 —5] weekis) on

.First_thursday,_of_manth (& Wesky el

. First_tuesday_of_menth an | owew | e T W |

. First_wednesday_of_menth F

First_weekday_of_menth @ fhe [first = | ofthe [Biweskly_pay_days@Sys =]
. First_weekday_of_year
... Fridays  Yearly

~Duration

Effective: [opr | [T& S [Tamz = oo feen ] [TF = EE =

3. In the Description field, specify a description for the calendar that makes it
obvious when this calendar is valid. This description is very useful: it is
displayed in the fly-over text when you point to a calendar name in the list,

and helps you quickly determine which calendar you want to use.

4. Choose one of the following options:

¢ If the expression should be true every n days, in the This Happens ... field,
select Daily. Then, in the Daily field, specify the number of days between
occurrences. For example, if the expression should be true every day, leave
the selections at Daily and Every 1 day(s).

This Happens = | -Daily
£ Dy
© ieekly
£ Morthiy
 early
a1 _’ILI

Every |_1 i‘ day(s)

If the expression should be true every other day, specify Every 2 day(s).

¢ If the expression should be true on specific days every week, or every n
weeks, in the This Happens ... field, select Weekly. Then specify how
frequently this occurs, in the Every n week(s) field. Then click on the
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appropriate days of the week. For example, if the expression should be true
on Mondays, Wednesdays and Fridays, click the MON button, then click the
WED button, then click the FRI button.

This Happens

£ Daly Every [ 1 i‘week(s)nn

. Wisskly ™ The following day(s)
© Morthy i [ = (=D TH
€ Vearly

@ The [t =] ofthe [Biweskly_pay_days@sys

4 I;Iﬂd | o

e If the expression should be true on specific days every month or every n
months, in the This Happens ... field, select Monthly. Then specify how
frequently this occurs, in the Every n month(s) field. Then click on the
appropriate dates or days of the week. For example, if the expression should
be true on the 6th day of every month, leave the frequency at every 1 month

and click 6.
“This Happens: | Monthi
" Daily Every |_1 :CI morthis) on
. Weskly & The following day(s)
SiHenty 5 = =

¢ If the expression should be true on specific days every year or every n years,
in the This Happens ... field, select Yearly. Then specify each date by
selecting the month and date and clicking Add. For example, if you want to
specify the last date of each month, in the month field, select Jan, and in the
date field, select 31. Continue to select the remaining dates.

Tip:

To quickly get to the later dates in the month, click down from 1 to get to 31.

This Happens... & |- vear

© Daiy Every year onthe date(s) in the list

e
" eekly MAR 2

UL 29
© Martthly AUG 18

SEP 25
& vearly L feer s

NOY 9

_'j pec - = Addd Remove

4 »

5. Optional. In the Duration field, specify the time in which this calendar should
be valid. If you want this calendar to be valid for an indefinite period of time,
do not specify any end date for the duration. The beginning of the time period
defaults to today’s date.

6. Optional. Verify that the expression yields the correct results: from the View
menu, select View Occurrences. A calendar is displayed with all of the
resulting dates highlighted.

7. Save the calendar: from the Calendar menu, select Save Calendar. When
prompted, specify a meaningful name for the calendar. Click Save. The
calendar is added to the list of centrally stored calendars, under your user
name.
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Create a calendar with a complex expression
About this task

Use this method to create a calendar when:

The calendar needs to be valid on certain days, but must exclude other days,
such as holidays

The calendar needs to be valid on dates that are already defined in one calendar,
and also on dates already defined in another calendar

Procedure

Open the Calendar Editor.

From the Calendar menu, select New Calendar and select Combine Calendars.
The combine calendars dialog box appears.

The dialog box is shown here with the list of calendars expanded on the left.

8 Process Manager: Calendar Editor - =) %]
Calendar View Window Help

e 62 |
Calendars =

T &£ Document3 & x|

EHED Svs [-Calendar Description
. Biweekly_pay_days
.. Businessdays

..Dally Description:

Last weekday of the month, except if it is 2 Monday

... First_businessday_of_month
... First_businessday_of_year
First_day_of _year
irst_friday_of_month

t s f th = =
O o IFirst_saturday_of_month Sys =

t_saturd th
Lt e P AL [First_sunday_of_month Sys

Owner:  clotito

Double click an calendars and operators b craate an expression.

Cperatars
In common with
Plus

irst_thursday_of_month
..First_tuesday_of_month

.. First_wednesday_of_month
.. First_weekday_of_month

.. First_weekday_of_year

.. Fridays

.. Holidays

.. Last_businessday_of_month
Last_businessday_of _year
ast_day_of_year
ast_weekday_of_month

.. Last_weekday_of _year

IFirst_thursday_of_month
[First_tuesday_of_month
[First_wednesday_of_month
IFirst_weekday_of_month
[First_weekday_of_year
[Fridays

IHolidays
lLast_businessday_of _manth
lLast_businessday_of _year
lLast_day_of_year
lLast_weekday_of_maonth
lLast_weekday _of_year

Sys
Sys
Sys
Sys
Sys
Sys
Sys
Sys
Sys
Sys

Mk

.. Mondays

. Saturdays paturdays i
Sundays Sys
. Sundays
IThursdays Sys
. Thrsdays e = .
. Tuesdays 3 ” _I
.. Wednesdays
. Weekdays Conbining Expression
. Weekends

Last_weekday_of_month@Sys Mot in common with Mondays@Sys

Server: ib0ShO1.Isf.platForm. com: 3496

3.

In the Description field, specify a description for the calendar that makes it
obvious when this calendar is valid. This description is very useful: it is
displayed in the fly-over text when you point to a calendar name in the list,
and helps you quickly determine which calendar you want to use.

Create an expression that combines the calendars as required: double-click on

calendar names and operators to create the desired expression. See “Operators
and their meanings” for a description of the operators.

Tip:

To see the operators, you may need to drag the operator window over from the
very right-hand side of the main window.

For example, if you want to create a calendar that is true on Mondays and
Tuesdays, double-click on the calendar Mondays. Then double-click on Plus,
then double-click on the calendar Tuesdays. The new calendar will be valid
every day that Mondays is valid plus every day that Tuesdays is valid.
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5. Optional. Verify that the expression yields the correct results: from the View

menu, select View Occurrences. A calendar is displayed with all of the
resulting dates highlighted.

Save the calendar: from the Calendar menu, select Save Calendar. When
prompted, specify a meaningful name for the calendar. Click Save. The
calendar is added to the list of centrally stored calendars, under your user
name. For information on naming calendars, see “About calendar names”
section.

Operators and their meanings

When creating a calendar expression, you can choose from the following operators:

Operator

Description

In common with

Use this operator to resolve to the intersection of two sets
of dates—only those dates in common between two

calendars

Plus Use this operator to combine two sets of dates—any of
the dates specified in the two calendars

Not Use this operator to exclude the dates in a calendar—use

only those dates that are not included in the calendar.

Use this operator to begin an expression nested within
the expression

Use this operator to end an expression nested within the
expression.

Not in common with

Use this operator to exclude dates. First specify the
expression that resolves to the dates you do want to
include, then use this operator followed by those dates
you do not want to include.

Calendar examples

Each of the these examples assumes that the Calendar Editor is up and running.

Example: Mondays, except on holidays

1.

Ensure you have a calendar that repeats every Monday. Typically, that is the
system calendar Mondays@Sys.

Ensure you have a calendar called “Holidays’ that defines all of the
non-working holidays for your company. Typically, that is the system calendar
Holidays@Sys.

From the Calendar menu, select New Calendar, then choose Combine
Calendars.

Define a combining expression that specifies ‘mondays’ but not ‘holidays’ as
follows:

Mondays@Sys Not in common with Holidays@Sys

Do this by double-clicking on Mondays@Sys, then double-click on Not in
common with, and then Holidays@Sys.

Tip:
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To see the operators, you may need to drag the operator window over from the
very right-hand side of the main window.

5. Provide a meaningful description for the calendar, and save it with a unique
name, such as ‘workingmondays’.

Example: every second Friday

1. From the Calendar menu, select New Calendar, then choose Specify Pattern.
2. Click Weekly.

3. In the Every n weeks field, specify 2.

4. Ensure The following days is selected, and click FRI, as follows:

This Happens Kt
£ paiy Bvery [ 2 —2] weekision

&
e The following day(s)

SLIN | MOR | TUE WWELD! THU | FRI SAT

1 Morthiy

C the [ = otthe [Biweekly_pay days@sys =
€ early

5. Provide a meaningful description for the calendar, and save it with a unique
name, such as ‘oddfridays’.

Example: last working Friday of month

1. Ensure you have a calendar that defines working days. Typically, that is the
system calendar businessdays@Sys.

2. Create a calendar called last_friday_of_month, similar to the system calendar
first friday of month@Sys.

3. From the Calendar menu, select New Calendar, then choose Combine
Calendars.

4. Define a combining expression that specifies last_friday_of_month and the days
it has in common with businessdays@Sys as follows:

last_friday_of _month@user In common with businessdays@Sys

Do this by double-clicking on last_friday_of_month, then double-click on In
common with, and then businessdays@Sys.

Tip:

To see the operators, you may need to drag the operator window over from the
very right-hand side of the main window.

5. Provide a meaningful description for the calendar, and save it with a unique
name, such as ‘lastworkingfriday’.

Edit an existing calendar
About this task

You can edit an existing calendar to change the dates on which it is valid, or you
can edit a calendar and save it using another name. You can use this method to

create a new calendar that is similar to an existing one.

You can edit only those calendars owned by your user ID.
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What you are able to change in a calendar depends on the method used to create
the calendar. For example, if the calendar was created using an expression, you
must change the expression to change the resulting dates.

You cannot change a calendar from one type to another. For example, if the
calendar was created by clicking on dates, you cannot change it to contain an
expression.

You use this option to change the dates on a calendar that was created by clicking
on dates:

Procedure
1. In the tree view on the left, double-click on the calendar you want to edit.

2. Deselect any previously selected dates you want to delete from the calendar by
clicking on them.

3. Click on any new dates that you want to add to the calendar.

4. From the Calendar menu, select Save Calendar, or close the calendar, at which
time you will be prompted to save it.

Edit a calendar to change the pattern
About this task

You use this option to change the dates on a calendar that was created by
specifying a pattern:

Procedure
1. In the tree view on the left, double-click on the calendar you want to edit.

2. Ensure you remove any previously selected dates you no longer want selected.
For example, if the current pattern includes Mondays and Tuesdays, but the
new pattern will be Tuesdays and Fridays, you need to click on Mondays to
remove the selection.

3. Specify the new pattern.

4. From the Calendar menu, select Save Calendar, or close the calendar, at which
time you will be prompted to save it.

Edit a calendar to change calendar combinations
About this task

You use this option to change the dates on a calendar that was created by
combining calendars:

Procedure
1. In the tree view on the left, double-click on the calendar you want to edit.

2. Edit the combining expression: you can delete terms in the expression by
highlighting them and clicking the Delete button. However, if you want to
insert terms from the list by double-clicking on them, they will be inserted at
the end of the expression.

3. From the Calendar menu, select Save Calendar, or close the calendar, at which
time you will be prompted to save it.
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Delete a calendar
About this task

Periodically, you may want to delete unused calendars from Process Manager. You
can only delete those calendars owned by your user ID.

Procedure

1. In the tree view on the left, right-click on the calendar you want to delete.
2. Select Delete Calendar.

3. Confirm that you want to delete the calendar by clicking Yes.
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Chapter 3. Define your flow

You use the Flow Editor to create or edit flow definitions that group related jobs,
job arrays and subflows, so that they can be triggered, run, and controlled as a
unit.

Tip:

Flow Editor may not be installed if you purchased the Platform Suite for SAS. For
more information, contact your sales representative.

About the Flow Editor user interface
The Flow Editor user interface consists of a workspace and a design palette to

define work items in the flow definition: jobs, job arrays, manual jobs, subflows,
time events, file events, proxy events, link events, and alarms.

About the toolbar

The Flow Editor toolbar looks like this:

R —
Open a flaw. Paste wwkl-m
ol
"'""h"’ UM 10 PRSIt
el r‘

HEEREEEDRRE

About the design palette

The Flow Editor design palette can be separated from the toolbar, and moved to a
convenient location in the work space. It looks like this:

Ways to create a flow definition
About this task

BSOS IN

There are many ways to create a flow definition. These are three of them:
1. Completely define one job at a time
2. Draw all of the work items in the flow and then fill in the details

3. A combination of the above methods—draw some of the work items and define
them, then draw more work items and define them, and so on

Note:
To support multiple Process Manager servers in a single LSF cluster, you must
ensure that each combination of user name and flow name is unique within the

cluster. This avoids conflicts and ensures that each job is unique among the
multiple Process Manager servers.
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Procedure
1. One job at a time
a. Draw the first job on the workspace
b. Define the details of the job
c. Draw the next job
d. Define the details of that job
e. Draw the dependency line between the two jobs
f. Continue with the next job in the flow, and repeat
2. Draw the flow, then fill in the details
a. Draw all of the jobs, flows and events on the workspace

b. Draw the dependency lines between the work items, establishing the
relationships between them

c. Define the details for each job and job array, one at a time
3. Combine methods 1 and 2
a. Draw a group of jobs, job arrays and flows on the workspace
b. Draw the dependency lines between those work items
c. Define the details for each job and job array, one at a time
d. Create another section of the flow

There is no right or wrong way. Only you can decide which method works
best for you

How do | know if a job or job array is undefined?
About this task

There are two ways in which Process Manager informs you if you have drawn a
job or job array but not yet defined it:

Procedure
1. The system-assigned job name is displayed in red text

2. When you save a flow that contains undefined jobs or job arrays, you receive a
message that lists all of the undefined work items in the flow

Using the example flows

The Process Manager Client package includes sample flow definitions that you can
use, to test your Process Manager installation, or to learn from or to modify for
your own use. These examples are located in the examples directory of the Client
installation. Each example is a simple flow that illustrates a particular type of

activity:
The flow definition named... Illustrates...
Example_1 * A simple job dependency, where one job runs when its
predecessor completes successfully
Example_2 * The use of a recovery job
Example_3 * The use of a manual task and a job array
Example_4 * The use of a file event to trigger some processing
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The flow definition named... Illustrates...

Example_5 * The use of a time event to run a job array, which raises
an alarm if it misses its schedule*

*To successfully use this flow definition, your administrator must first define an alarm called Critical_Job_Failed

You can open these flows to view them from the Flow Editor, but if you want to
run them or use them to create a new flow, unless you have Process Manager
administrator authority, you must change the owner of each work item in the flow
before you can successfully run any of the sample flows.

View the sample flow definition
Procedure
1. In the Flow Editor, from the File menu, select Open.
2. Locate the examples directory within the Client installation.
3. Select a flow definition and click OK.

Use a sample flow definition
Procedure
1. Open the flow definition as described above.
2. Double-click on a job or job array in the flow definition.
3. On the General tab, locate the Run as... field at the bottom of the dialog.
4.

Change the user name to your user ID, and click OK.

Create a flow diagram

For purposes of clarity, this topic assumes you will drag and drop all of the jobs
onto the workspace, creating a visual representation of the work flow, and then
define each job in the workspace.

Create a simple flow diagram
Procedure

1. Click the Insert Job button to put the Flow Editor in job placement
mode—when you left-click in the workspace, a job icon appears.

2. Drop the appropriate number of job icons in the workspace, placing them in
the order in which you want the jobs to run, typically with the first job to run
at the left and the last job to run at the right. Unique job names are assigned
automatically to the jobs in the workspace. You can change these later if you
like.

3. Change to job dependency mode by clicking the Insert Dependency button.

4. Draw job dependencies by left-clicking on the job that must run first, then
left-clicking on the job that runs next. The job at the arrow end of the line
cannot run until the job at the originating end of the arrow completes.

Refer to the following example:

H 2
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Job J2 cannot run until job J1 completes.
5. Double-click on each job in the flow definition. The Edit Job dialog appears.

6. In the Command to run field, specify the command that this job is to run. For
example, on Windows:

1 Define the Joh

Marme: H

Gomrand to rur [ User dpplicationsiapp1

Login shellto use: | | Partof project: y
or on UNIX:
“Define the Job
Name, 1
Cammand tarun:  [Lisrishare/app1]
Login shellto use: | x| Partof project

7. In the remaining input fields and tabs, specify any other details required to
define the job.

8. Save the flow definition. You can save it in your local file system or in a shared
file location.

Other things you can do

You can also do the following;:

Procedure
* Copy a job
¢ Print the flow definition

Copy a job
Procedure
1. Right-click on the job you want to copy, and select Copy.

2. Right-click in the workspace where you want to place the new job, and select
Paste.

3. Optional: double-click on the new job and change the name of the job.

Print the flow definition
Procedure
1. From the File menu, select Print Preview to see how your flow definition looks

on paper. You can adjust the spacing in your flow to avoid breaking icons at a
page boundary.

2. From the File menu, select Print... and click OK.

Include a job array in the flow diagram

You can include a job array in the flow diagram. Using a job array is a convenient
way to specify a group of jobs that share the same executable and resource
requirements, but use different input data, with a single definition. All jobs in a job
array have the same name and same job ID. Each job runs the same executable.
Any parameters you specify apply to all jobs in the array. All jobs use an input file
from the same location, and write to the same output file location. However, each
element of a job array is distinguished by its array index. Before you can use a job
array, you need to prepare your input files. See “Job Arrays” chapter in
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Administering Platform LSF for more information. The maximum number of jobs in
a job array is defined with the LSF MAX_JOB_ARRAY_SIZE parameter in the LSF
configuration file 1sb.params. When a job array index is larger than the value
defined by MAX_JOB_ARRAY_SIZE in Tsb.params, the job array submission is

rejected.

Insert a job array
Procedure

1.

2.

Click the Insert Job Array button to change to job array placement
mode—when you left-click in the workspace, a job array icon appears.
Left-click in the workspace in the location where you want to insert the job
array. A job array icon appears in the workspace.

Draw the lines describing any dependencies the job array has on other work
items in the flow.

Define job array details
Procedure

Define the Job Arra

MName:

Command torun: |

. Double-click on the job array. The Edit Job Array dialog appears.

IM Index expression

Login shellto use: [ | Partorproject o

2. In the Name field, specify a name for the job array. You can use alphabetic
characters, numerals 0 to 9, period (.), dash (-) and underscore (_) in the job
array name. A unique name is automatically assigned to the job array, but you
can change it to make it more meaningful.

3. Create an index expression using one of the following methods.
a. Freeform expression: In the Index expression field, specify an expression

that defines the index for the array. The index expression can be a simple
range of positive integers, such as

1-5

or a series of comma-separated numbers, such as
1,4,5,6,8

In this example, the job array will consist of five jobs.
The index expression can also be in the format
start-end[:step]

where start is used to specify the start of a range of indices, and end
specifies the end of the range. step specifies the value to increment the
indices in the range. The index begins at start, increments by the value of
step, and does not increment past the value of end. For example:

1-10:2
specifies a range of 1 to 10 with a step value of 2, creating indices of

1,3,5,7 and 9. This creates 5 jobs in the job array, whose input files will
have suffixes of .1, .3, .5, .7 and .9 respectively.

You can also specify a user variable for any of the values in the index
expression—start, end or step. For example:

1-#{COUNT}
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Job Array Indext Expression Builder F x|

Index(s) List:

where the value of COUNT might be set within a job that runs prior to
this job array in this flow.

b. Using the Job Array Index Expression Builder dialog.

1) Click the ... button next to the Index expression field. The Job Array
Index Expression Builder dialog appears.

1-10:2

Add

Remove

Start:

End:

Step.

OK Cancel

2) In the Start field, specify the start of the range of indices, which will be
the first job name suffix. For example: 1. Or specify a variable. For
example: #{beginix}

3) In the End field, specify the end of the range of indices. For example:
10. Or specify a variable. For example: #{endix}

4) Optional. In the Step field, specify the value to increment the indices in
the range. The default is a step of 1. For example: 2. Or specify a
variable. For example: #{stepix}

5) Click Add to add the expression to the list.

6) Repeat steps ii through v until you have completed specifying all the
index ranges.

7) Click OK. The expression you created is inserted in the Index
expression field.

In the Command to run field, specify the command that each of the jobs in
the array will run. Include any arguments the command requires.

Ensure that all the input files for the jobs in your job array are in the same
directory. By default, the current working directory is assumed. If the files are
not in the current working directory, specify an absolute path as seen by the
Process Manager Server.

Also ensure that all the input files have the same name, with a numerical
suffix that corresponds to the index of the job array element that will use it.

In the Input file field, specify the name of the input file, as follows:
input_file_name . %1

which specifies to use the input file that corresponds to the index for each
element in the array. For example:

input.l
In the Output file field, specify the name of the output file, as follows:
output_file_name.%1 .%J

which specifies to create an output file that corresponds to the index, followed
by the job ID for each element in the array. For example:

output.1.3993

Optional: In the Max. concurrent jobs field, specify the maximum number of
jobs in the array that can run at the same time.

Specify any additional options on this tab and the other definition tabs.
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10. Click OK.
Preparing job array input files

Process Manager provides methods for coordinating individual input and output
files for the multiple jobs created when submitting a job array. These methods
require your input files to be prepared uniformly. To accommodate an executable
that uses standard input and standard output, Process Manager provides variables
that are resolved at runtime: %I (job array index) and %] (job ID).

All input files for your job array must be located in the same directory. Specify an
absolute path to the directory containing the input files when defining your job
array.

Each file consists of two parts: a consistent name string and a variable integer that
corresponds directly to an array index. For example, the following file names are
valid input file names for a job array. They are made up of the consistent name
input and integers that correspond to job array indices from 1 to 1000:

input.l, input.2, input.3, ..., input.1000

Include a job submission script in the flow diagram
About this task

You can define and submit customized job submission scripts to control and
monitor jobs.

Procedure

1. Click the Insert Job Script button to change it to placement mode—when you
left-click in the workspace, a job submission script icon appears.

2. Left-click in the workspace in the location where you want to insert the job
submission script. A job submission script icon appears in the workspace.

3. Draw the lines describing any dependencies the job submission script has on
other work items in the flow.

Define job details
Procedure
1. Double-click on the job submission script. The Edit Job dialog appears.

2. In the Name field, specify a name for the job submission script. You can use
alphabetic characters, numerals 0 to 9, period (.), dash (-) and underscore (_) in
the job submission script name.

3. In the File field, specify the absolute pate of the job submission script. Ensure
that this path is accessed and executed by Process Manager Daemon jfd. Make
sure that your script meets the conditions as explained in [Content of job /job|
[array submission script,

4. Specify any additional options on this tab and the other definition tabs. For
detailed information about each of the options, see

5. Click OK.
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Include a job array submission script in the flow diagram
About this task

Using a job array submission script is a convenient way to specify a group of job
submision scripts that share the same executable and resource requirements, but
use different input data, with a single definition. Any parameters you specify
apply to all job submission scripts in the array. All jobs use a file from the same
location. However, each element of a job array submission script is distinguished
by its array index. Before you can use a job array submission script, you need to
prepare your input files.

Procedure

1.

Click the Insert Job Array Script button to change it to placement
mode—when you left-click in the workspace, a job array submission script icon
appears.

Left-click in the workspace in the location where you want to insert the job
array submission script. A job array submission script icon appears in the
workspace.

Draw the lines describing any dependencies the job array submission script has
on other work items in the flow.

Define job array details
Procedure

1.

7.

Double-click on the job array submission script. The Edit Job Array dialog
appears.

In the Name field, specify a name for the job array submission script. You can
use alphabetic characters, numerals 0 to 9, period (.), dash (-) and underscore
(L) in the job array submission script name.

Create an index expression as explained in the job array details section.

Ensure that all the script files for the jobs in your job array are in the same
directory. By default, the current working directory is assumed. If the files are
not in the current working directory, specify an absolute path as seen by the
Process Manager Server.

Also ensure that all the input files have the same name, with a numerical suffix
that corresponds to the index of the job array element that will use it.

In the File field, specify the job array submission script directory. This directory
should be easily accessible for Process Manager Daemon jfd. Make sure that
your script meets the conditions as explained in [Content of job/job array]
[submission script]

Specify any additional options on this tab and the other definition tabs. For
detailed information about each of the options, see [Details of a Job

Click OK.

Content of the job/job array submission script
About this task

Process Manager can successfully track the job/job arrays submitted through the
customized scripts only if these conditions are met:
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Procedure

1. Specify job name (JS_JOB_NAME) and job array index (JS_INDEX_LIST) in the
job/job array submission script.

For example,

bsub -g short -R "mem>1000" -J $JS_JOB_NAME$JS INDEX_ LIST my_command
2. Submit only one job or job array through the job/job array submission script.
3. Do not use the following bsub options in the script:

a. -1/-Ip/-Is — interactive jobs

b. -K — submit a job and wait for the job to complete

4. The script must exit zero upon successful submission, or non-zero otherwise.

Include a static subflow in the flow diagram
About this task

At any time, you can include an existing flow definition as a static subflow within
a flow diagram. This is especially useful for standardized flow definitions that you
would like to reuse, such as backup and recovery routines, database update
routines, and so on.

Procedure

1. Click the Insert Static Subflow button to put the Flow Editor in static subflow
placement mode. The Open dialog appears.

2. Locate the flow definition file you want to include and click Open.

3. Left-click in the workspace in the location where you want to insert the static
subflow. The static subflow icon is added to the flow diagram.

4. Draw the lines describing any dependencies the static subflow has on other
work items in the flow definition.

5. Optional. Specify additional attributes for the static subflow.
a. Right-click the static subflow and select Attributes.

b. To specify a working directory at the subflow level, use the Working
directory field.

Tip:

You can use user variables when specifying the working directory.

All valid inner work items (subflows, jobs, and job arrays) in the static
subflow will use this directory as the working directory unless you further
specify a working directory for the inner work item. In this case, the
working directory setting for the inner work item will override the setting
for this static subflow.

c. To add input variables to the static subflow, click Modify, which is beside
the Input Variables field.

From the Input Variables window, specify variables in the form of
Name=Value. You can also specify user variables as input values.

When Process Manager expands static subflows, these input variables are
set at the subflow level.

Note:
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If you set default values (by enabling Specify a Default Value), this creates
both environment variables and user variables.

d. To specify a description or instructions regarding the subflow, use the
Description field.

e. To monitor this subflow for a particular exception and handle it
automatically, click the Exception Handling tab and specify the exceptions
and handlers.

For more detailed information about exceptions and handlers, see

[Exception:

f. Click OK to save the subflow settings.
Tip:
You can view (and edit) the jobs in a subflow by double-clicking on the

subflow, or by right-clicking the subflow and selecting Open Definition. Any
changes you make apply only to the imbedded subflow.

Include a static flow array in the flow diagram
About this task

You can include a static flow array as a subflow within a flow diagram. A static
flow array works in a similar fashion to a job array, but at a subflow level.

When the static flow array is instantiated, a specific number of flow elements start
to run either in parallel, or sequentially, depending on what you selected in the
flow array attributes. By default, flow elements run in parallel.

Within a flow array element, the #{JS_FLOW_INDEX} scoped variable specifies the
array index of the static flow array element.

Procedure

1.

Click the Insert Static Flow Array button to put the Flow Editor in static flow
array placement mode. The Open dialog appears.

Locate the flow definition file you want to include and click Open.

Left-click in the workspace in the location where you want to insert the static
flow array. The static flow array icon is added to the flow diagram.

Draw the lines describing any dependencies the static flow array has on other
work items in the flow definition.

Define the static flow array.
a. Right-click the static flow array and select Attributes.
The Flow Array Attributes dialog displays.
b. Specify the name of the static flow array in the Name field.

The default name assigned to the static flow array is the name of the
subflow you selected.

c. Optional. To specify the description of the static flow array, use the
Description field.

d. Define the size of the array by specifying the First Element and Last
Element fields.

If you do not specify a value for First Element, it defaults to 1. You must
specify a value for Last Element that is larger than First Element.
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Tip:

You can use user variables in the element fields to specify the flow array
index, thus allowing static flow arrays with dynamic element fields. At
runtime, before the static flow array is started, Process Manager replaces the
variables with values, which is usually set be a predecessor job.

e. Optional. Specify Run flow array elements: whether flow array elements
run in parallel or sequentially. By default, flow array elements run in
parallel, as checked.

6. Optional. To specify a working directory at the static flow array level, expand
the static flow array and use the Working directory field in the Flow Attributes
of the flow array.

Tip:

You can use user variables when specifying the working directory.

All valid inner work items (subflows, jobs, and job arrays) in the static flow
array will use this directory as the working directory unless you further specify
a working directory for the inner work item. In this case, the working directory
setting for the inner work item will override the setting for this static flow
array.

7. Optional. Monitor this static flow array for a particular exception, and handle it
automatically.
For more detailed information about exceptions and handlers, see
[Exceptiond
a. Right-click the static flow array and select Expand to enter the subflow

level.

b. Right-click on the workspace and select Attribute.
c. Click the Exception Handling tab and specify the exceptions and handlers.

Tip:

You can view (and edit) the jobs in the subflow in the flow array by
double-clicking on the flow array or by right-clicking on the flow array and
selecting Expand. Any changes you make apply only to the subflow in the flow
array.

8. Click OK to save your static flow array definition.

Flow array element names

When a static flow array is run, each element takes a unique name in the form of
flow_array _name(array_index).

For example, if the name of the static flow array instance is 1:usrl:FA, and its

index is 1 to 3, the three elements have the name of 1:usrl:FA(1), 1:usrl:FA(2),
and 1:usrl:FA(3).

Viewing a static flow array

Procedure
1. Right-click the static flow array in the instance diagram and select View
Elements.

A list of flow array elements displays.
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2. Select one of the flow array elements and click View Flow.
The diagram for the selected flow array element displays.

Include a dynamic subflow in the flow diagram
About this task

At any time, you can include an existing flow definition as a dynamic subflow
within a flow diagram. A dynamic subflow, also called a subflow by reference,
refers to a target flow that has already been submitted to Process Manager. Only
flows that have been submitted to Process Manager and published are eligible
target flows for dynamic subflows.

When you modify the definition of the target flow, all the dynamic subflows that
reference this target flow can obtain the latest version.

Procedure

1. Click the Insert Dynamic Subflow button to put the Flow Editor in subflow
placement mode.

The Dynamic Subflow - Insert dynamic subflow window displays.
2. Specify the attributes for the dynamic subflow.
a. In the Name field, specify a name for the dynamic subflow.

b. In the Choose a flow to insert field, select a target flow for the dynamic
subflow.

The eligible target flows are shown in the form of user_name:flow_name.
Only flows that have been submitted to Process Manager and published are
shown in this field.

c. To add input variables to the dynamic subflow in the Specify input
variable values field, click Modify. The Input Variables window displays.

The variables are set in the form of Name=Value. You can specify user
variables as input variable values. When Process Manager expands dynamic
subflows, these input variables are set at the subflow level.

Note:

If you set default values (by enabling Specify a default value), this creates
both environment variables and user variables.

d. Select how you want Process Manager to update the dynamic subflow
when the main flow is instantiated.

* Use the default setting specified in the main flow
* Automatically update to the default version
* Manually update to the default version

e. Click OK to save your dynamic flow definition.

3. Left-click in the workspace in the location where you want to insert the
dynamic subflow. The dynamic subflow icon is added to the flow diagram.

4. Draw the lines describing any dependencies the dynamic subflow has on other
work items in the flow definition.
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Include a dynamic flow array in the flow diagram
About this task

You can include a dynamic flow array as a subflow within a flow diagram. A
dynamic flow array works in a similar fashion to a job array, but at a subflow
level.

When the dynamic flow array is instantiated, a specific number of flow elements
start to run either in parallel, or sequentially, depending on what you selected in
the flow array attributes. By default, flow elements run in parallel.

A dynamic flow array, also called a flow array by reference, refers to a target flow
that has already been submitted to Process Manager. Only flows that have been
submitted to Process Manager and published are eligible target flows for dynamic
flow arrays. The target flow is essentially converted into a dynamic flow array in
which each array element is equivalent to the target flow.

Within a dynamic flow array element, the #{JS_FLOW_INDEX} scoped variable
specifies the array index of the dynamic flow array element.

Procedure

1. Click the Insert Dynamic Flow Array button to put the Flow Editor in dynamic
flow array placement mode.

The Dynamic Flow Array - Insert dynamic flow array window displays.
2. Specify the attributes for the dynamic flow array.
a. In the Name field, specify a name for the dynamic flow array.

b. In the Choose a flow to insert field, select a target flow for the dynamic
flow array.

The eligible target flows are shown in the form of
user_name:flow_array_name. Only flows that have been submitted to
Process Manager and published are shown in this field.

c. Define the size of the array by specifying the First Element and Last
Element fields.

If you do not specify a value for First Element, it defaults to 1. You must
specify a value for Last Element that is larger than First Element.

Tip:

You can use user variables in the element fields to specify the flow array
index, thus allowing flow arrays with dynamic element fields. At runtime,
before the dynamic flow array is started, Process Manager replaces the
variables with values, which is usually set be a predecessor job.

d. To add input variables to the dynamic flow array in the Specify input
variable values field, click Modify. The Input Variables window displays.
The variables are set in the form of Name=Value. You can specify user
variables as input variable values. When Process Manager expands dynamic
flow arrays, these input variables are set at the subflow level.

e. Select how you want Process Manager to update the dynamic flow array
when the main flow is instantiated.

* Use the default setting specified in the main flow
* Automatically update to the default version
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* Manually update to the default version

f. Optional. Specify Run flow array elements: whether flow array elements
run in parallel or sequentially.

g. Click OK to save your dynamic flow array definition.

3. Left-click in the workspace in the location where you want to insert the
dynamic flow array. The dynamic flow array icon is added to the flow diagram.

4. Draw the lines describing any dependencies the dynamic flow array has on
other work items in the flow definition.

Dynamic flow array element names

When a dynamic flow array is run, each element takes a unique name in the form
of flow_array_name(array_index).

For example, if the name of the dynamic flow array instance is 1:usrl:FA, and its

index is 1 to 3, the three elements have the name of 1:usrl:FA(1), 1:usrl:FA(2),
and 1:usrl:FA(3).

Viewing a dynamic flow array

Procedure
1. Right-click the dynamic flow array in the instance diagram and select View
Elements.

A list of dynamic flow array elements displays.
2. Select one of the dynamic flow array elements and click View Flow.

The diagram for the selected dynamic flow array element displays.

Include a manual job in the flow diagram
About this task

You can include a manual job in the flow diagram wherever you want to indicate a
manual process that must take place before the flow can continue. Successors of
the manual job cannot run until the manual job is explicitly completed.

When the flow is ready for the manual job to be completed, an email is sent to the
owner of the flow or job. When you define the manual job, you specify the email
address and the text to be included in the email.

Including a manual job in a flow does not stop the entire flow from processing:
only the specific path containing the manual job is halted until the job is
completed.

Procedure

1. Click the Insert Manual Job button to put the Flow Editor in manual job
placement mode—when you left-click in the workspace, a manual job icon
appears.

2. Left-click in the workspace in the location where you want to insert the manual
job.

3. Draw the lines describing any dependencies the manual job has on other work
items in the flow definition.
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Define manual job details
Procedure
1. Double-click on the manual job. The Manual Job dialog appears.

Manual Job Definition - Edit manual job' x|

- Define manual job

Job name: rt

Email address; etotito]

Mon-zero success exit codes: |

Message:

Description:

| Erenl| |

2. In the Job name field, specify a unique, meaningful name for the manual job.
You will use this name when completing the job as the flow runs. You can use
alphabetic characters, numerals 0 to 9, period (.), dash (-) and underscore (_) in
the manual job name. The Flow Editor assigns a unique name to each manual
job when you draw it on the workspace, so you are not required to change the
name. However, if you want to change the name, you can. The name itself is
required.

3. In the Email address field, specify the email address to notify when the job is
ready for completion. If you do not change the email address, it defaults to
your user ID. If you delete the email address, no notification is sent when the
job requires completion.

4. In the Non-zero success exit codes field, specify which numbers in addition to
0 represent success for the job. Specify a list of space-separated numbers from 1
to 255.

5. In the Message field, specify the message text that should appear in the email
notification. For example, if the manual job will be used to verify a report, you
might include the following as the message text:

Verify the output of report paylist.
You can also specify a variable in the message. For example:
Check output from printer #{PRINT}.

6. In the Description field, add any descriptive text that may be used for
managing this job within the flow. For example, if this job requires special
instructions for operations staff, place those instructions here.

7. Click OK. The manual job appears in the workspace, and you can draw the
appropriate dependency lines to any work items.

Specifying custom exit codes for successful job completion

By default, for a job to complete successfully, the exit code must be 0. Any other
exit code indicates the job failed.

In some cases, however, you may want to use exit codes to pass information to

subsequent work items and may want to use numbers other than 0 to indicate
success.
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You can do so by specifying these exit codes in the Job Definition dialog, Job Script
Definition dialog, Manual Job Definition dialog, or Local Job Definition dialog,
Non-zero success exit codes field.

This feature applies to LSF jobs, job scripts, local jobs, and manual jobs.

When you define custom success exit codes:

* 0 is always a success exit code, and is the default success exit code. You do not
need to specify it.

* You can specify one number or a list of numbers separated by spaces, from 1 to
255.

* You can use user variables in the Non-zero success exit codes field. If the user
variable cannot be resolved at runtime, it is ignored.

* When a job exits with 0 or any other specified success exit code, the job is
considered successful and receives the Done state.

* When a job exits with an exit code other than 0 or the specified success exit
codes, the job is considered to have failed and receives the status Exited.

* If you specify an application profile and SUCCESS_EXIT_VALUES is defined in
Isb.applications for the application, SUCCESS_EXIT_VALUES is ignored.

 If ajob is killed by a user in Process Manager or in LSE, custom success exit
codes are ignored.

From Flow Editor

Procedure

1. In Flow Editor, right-click on a job, job script, manual job, or local job, select
Open Definition.

2. In the Non-success exit codes field, enter the exit codes that represent
successful completion of the job.

Include a local job in the flow diagram

About this task

You can include a local job in the flow diagram.

A local job is a job that will execute immediately on the Process Manager host
without going through LSE. A local job is usually a short and small job. It is not
recommended to run long, computational-intensive or data-intensive local jobs as it
can overload the Process Manager host.

There are several differences between local jobs that run on Windows, and local
jobs that run on Linux and UNIX:

Item

Windows Linux/UNIX

Behavior

The local job is blocking: when a local The local job is non-blocking: that is,
job is running, another local job will  several local jobs can be run in

not be able to run until the local job  parallel.

that is running completes.
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Item

Windows

Linux/UNIX

Killing a local job

You cannot directly kill a local job in
the same way as you kill any other
job.

The local job can only be killed as a
result of the flow being killed, or if it
runs for longer than the configured
timeout value.

You can kill a local job in the same
way as you kill any other job. The
local job may also be killed as a result
of the flow being killed, or because it
ran for longer than the configured
timeout value.

Suspending and resuming a local job

If you suspend or resume a flow that
contains local jobs, the local jobs will
be killed and rerun.

If you suspend or resume a flow that
contains local jobs, the local jobs will
also be suspended or resumed.

Viewing runtime attributes

You can view a local job’s runtime
attributes in Flow Manager. Note,
however, that no resource usage is
available for the local job.

You can view the exit status and CPU
usage of a local job after the job
completes. The process ID identifies
the local job and you can view CPU
usage for the job. You can also view
the process ID of the job and CPU
usage information with jflows -1
flow_id and jhist -C job.

Timeout for local jobs

By default, a local job has a timeout
so it will be killed if it was running
for too long.

By default, a local job can run
indefinitely; it does not have a
timeout. The Process Manager
administrator can, however, define a
timeout value for a local job and it
will be killed if it the job was running
for too long.

Procedure

1. Click the Insert Local Job button to put the Flow Editor in local job placement
mode—when you left-click in the workspace, a local job icon appears.

2. Left-click in the workspace in the location where you want to insert the local

job.

3. Draw the lines describing any dependencies the manual job has on other work
items in the flow definition.

Define local job details
About this task

After placing a local job in the flow diagram, you can open and edit its definition
as you would for other jobs.

Procedure

1. Double-click on the local job. The Job Definition dialog appears.

2. Specify the local job details.

The following fields are mandatory

* In the Name field, specify a unique, meaningful name for the local job. The
default value is LJnumber (wWhere number is the total number of local jobs
inserted into the same flow) and is automatically specified when you first
define the local job. You can use alphabetic characters, numerals 0 to 9,
period (.), dash (-) and underscore (_) in the local job name.
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* In the Command to run field, specify the actual command to run, including
the file path to the command and its arguments.

* In the User name field, specify the user name under which the command is
run. If you are not one of the Process Manager administrators, you must
specify your own user name. The default is your own user name.

To set variables for local jobs, use variable files. You cannot use the command
ppmsetvar to set variables for local jobs.

The following fields are optional. If undefined, Process Manager uses the
default values:

* In the Working Directory field, specify the directory in which the command
is run. The default is the home directory of the user under which the
command is run.

* In the Environment Variables field, specify a list of extra key-value pairs to
be set up in the environment for use by the command. This field cannot be
edited manually — you must click Modify and use the dialogs to specify the
key-value pair. The default is undefined.

* In the Non-zero success exit codes field, specify a list of space-separated
numbers from 1 to 255. Use this field to indicate which numbers in addition
to 0 represent success for the job.

¢ In the Disable suspension for this job field, select it in cases where you do
not want to suspend a running local job when the flow is suspended. If this
field is selected, when the flow is suspended, the running local job will not
be suspended - it will continue to run. Only available for local jobs on
UNIX/Linux.

* In the Enter Description field, add any descriptive text that may be used for
managing this job within the flow. The default is undefined.

You can specify user variables in all fields except the Name and Description
fields. For the Environment Variables field, you can only specify user variables
in the value section of the key-value pair.

3. Click OK to save your changes.

Running a local job

When Process Manager triggers a flow containing a local job and the local job’s
dependencies are met, the local job will start to run.

The local job can be depended upon based on the following types of conditions:

¢ Completes successfully: The job completes with exit code 0, or any other
number specified in the Non-zero success exit codes field.

* Fails: The job fails.
* Ends with any exit code: The job exits with any exit code, including 0.

* Ends with exit code: The job exits with a particular exit code pattern. For
example, not-equal-to, equal-to.

Insert a job to another batch system

About Other Batch Jobs

In your flow, you may have jobs that you need to run on remote batch systems or
workload managers that are not LSF. Process Manager can be configured by the
administrator to communicate with the Other Batch System so that users can add a
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job in their flow and submit a job to the Other Batch System, and track and control
the job like any other job in their flow. The Job Definition for Other Batch jobs can
be customized by the administrator.

Limitations

Other Batch jobs are only supported when the Process Manager Server is on
UNIX/Linux.

Job Definition

When Process Manager is configured to communicate with the Other Batch
System, you will see the Other Batch Job work item enabled in Flow Editor:

In the Job Definition, you specify the command to run, other job submission
options, and the user account under which the job is to run in the Other Batch
System.

Job monitoring and control

You monitor an Other Batch job in the same way as you monitor any other job. In
the job’s runtime attributes, you can view the same job information that you can
view for any LSF job.

The following actions can be taken on an Other Batch job:

¢ Kill: You can kill Other Batch jobs in the same way as you kill any other job. The
job may also be killed as a result of the flow being killed. Note that the state of
the job will not change until the job is actually killed in the Other Batch System.
When you kill a flow that contains Other Batch jobs, the state of the flow
immediately changes, but the state of the Other Batch job does not change until
the job is actually killed in the Other Batch System.

* Suspend: If you suspend a flow that contains Other Batch jobs, Other Batch jobs
will also be suspended. When you suspend a flow that contains Other Batch
jobs, the state of the flow immediately changes, but the state of the Other Batch
job does not change until the job is actually suspended in the Other Batch
System.

* Resume: If you resume a flow that contains Other Batch jobs, Other Batch
System jobs will also be resumed. When you resume a flow that contains Other
Batch jobs, the state of the flow immediately changes, but the state of the Other
Batch job does not change until the job is actually resumed in the Other Batch
System.

It is possible that jobs submitted to different batch systems have the same job ID.
This is not a problem because jfd distinguishes jobs by job name.

Dependencies

The dependency types coming out of an Other Batch job are:

* Completes successfully: The job completes with exit code 0. If a job state is
Done, it is considered as "Completes Successfully", otherwise it is considered as
"Fails".
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* Fails: The job fails.
* Ends with any exit code: The job exits with any exit code, including 0.

* Ends with exit code: The job exits with a particular exit code pattern. For
example, not-equal-to, equal-to.

Failover and Other Batch jobs

Should jfd terminate abnormally, when it restarts it can recover running and
finished Other Batch jobs and determine their status and resource usage.

Include an Other Batch job in the flow diagram
About this task

Available only when Process Manager server is running on UNIX/Linux.

An Other Batch job is a job that is submitted to a remote batch system or workload
manager that is not LSE You can track and control the job like any other job in
your flow.

Procedure
1. Click the Other Batch Job button:

Note: The Other Batch Job icon will only be enabled if there are Other Batch
Systems configured.

2. Left-click in the workspace in the location where you want to insert the job.
The Other Batch Job icon is inserted in your flow definition.

3. Draw the lines describing any dependencies the job has on other work items in
the flow definition.

Define Other Batch System job details
About this task

After placing the Other Batch job in the flow diagram, you can open and edit its
definition as you would for other jobs.

Procedure

1. Double-click on the Other Batch job. The Job Definition dialog is displayed.
2. Specify the job details.

3. Click OK to save your changes.

Output and error file generation for work items in a flow

By default, output and error files are not generated for flows or individual work
items.

To troubleshoot flows, however, it is useful to always generate output and error
files for work items in the flow.
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You can set output and error file generation in the Flow Attributes. The behavior
to create output and error files is the same as using the LSF bsub command
options -0 and -e.

Output and error file settings that are defined in the Flow Attributes are inherited
by the following work items in the flow:

* Jobs

e Local jobs

* Job arrays

e Static subflows

e Static flow arrays
* Dynamic subflows

¢ Dynamic flow arrays

Output and error file settings do not apply to job scripts, job array scripts,
template jobs, or manual jobs.

Users can override output and error file settings that were defined in the flow in
individual work items.

Default location of output and error files

By default, output and error files are generated in the working directory of the
work item.

If the working directory is not specified, the location that is used for the working
directory is the execution user's home directory:

e Linux: $HOME
e Windows: $HOMEDRIVE%%HOMEPATH%

You can define a default working directory for flows with the parameter
JS_DEFAULT_FLOW_WORKING_DIR in js.conf. Users can override the default
working directory in individual work items.

Override order for output and error file generation settings

Joh

Subflow

SapLUaAD)

Flow

The override order for Process Manager to determine output and error file
generation, location, and naming is as follows (in order of highest precedence):

1. Use output and error file settings defined at the job level, in the Job Definition.

2. Use output and error file settings defined in the static subflow’s Flow
Attributes.

3. Use output and error file settings defined in the dynamic subflow’s Flow
Attributes:

 If Use parent flow’s settings is selected, use settings in the parent flow’s
Flow Attributes.
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 If Use inserted flow’s settings is selected, use settings in the inserted target
flow’s Flow Attributes.

 If Override parent flow’s settings and inserted flow’s settings is selected,
use settings in the Dynamic subflow Flow Attributes.

4. Use output and error file settings defined in the flow’s Flow Attributes.

Configuring output and error file generation for work items in

a flow
Procedure

1. In Flow Editor, from the menu select Action > Add Flow Attribute, and define
output and error file settings.

Field

Description

Create output files for jobs and job
arrays

Create error files for jobs and job
arrays

Select Yes to configure output and error file generation and naming
pattern.

Important: If you select to only generate output files, no error files are
generated but the content of the error file is appended to the output
file(same behavior as the LSF bsub -0 option).

Directory Specify a directory name or path relative to the flow's working directory.
Process Manager creates specified subdirectories in the working directory
if the directories do not exist.

File Name

Specify the naming pattern for files.

Built-in variables you can use:

* %u for user name

e %t for time stamp

* %] for job ID

¢ %I for job array element

Note: If you specify the file naming pattern to start with a path and use a
slash (/), this is interpreted as an absolute path by Process Manager. For
example: if your working directory is /home/userl, and you specify the
file naming pattern for output files to be /test/output/
output.#{JS_FLOW_FULL_NAME}.%J, the output file will be created outside

of the working directory in the directory /test/output, not within the
working directory.

Default file naming pattern for output files:

* Job: output.#{JS_FLOW_FULL_NAME}.%J

* Local job: output.#{JS_FLOW_FULL NAME}

* Job array element: output.#{JS_FLOW_FULL_NAME}.%J[%I]

Default file naming pattern for error files:

* Job: error.#{JS_FLOW FULL NAME}.%J

* Local job: error.#{JS_FLOW_FULL_NAME}

* Job array element: error.#{JS_FLOW_FULL_NAME}.%J[%I]

2. Click OK to save your changes.
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About variables in Process Manager

Types

Process Manager provides substitution capabilities through the use of variables.
When Process Manager encounters a variable, it substitutes the current value of
that variable.

You can use variables as part or all of a file name to make file names flexible, or
you can use them to pass arguments to and from scripts. You can export the value
of a variable to one or more jobs in a flow, or to other flows that are currently
running on the same Process Manager Server. You can also use variables in the
index expression of a job array definition, in the message sent when a manual job
requires completion, or when a job runs.

You can set a value for a single variable within a script, or set values for a list of
variables, and make all of the values available to the flow or to the Process
Manager Server. They can use a single variable or a list of variables within a job,
job array or file event definition.

of variables

Process Manager supports three types of variables:
* Built-in variables

» User variables

* Environment variables

Built-in variables

Built-in variables are those defined by Process Manager, where the value is
obtained automatically by Process Manager and made available for use by a flow.
No special setup is required to use Process Manager built-in variables. You can use
these variables in many of the job definition fields in Flow Editor.

User variables

User variables are those created by a user. To use a user variable, you must first
create a job that sets a runtime value for the variable and exports it to Process
Manager. You submit that job to a special queue that is configured to set variables.
See your Process Manager administrator for the queue name. Once a value has
been set for the variable, you can use the variable in many of the job definition
fields in Flow Editor.

There are two types of user variables Process Manager users can set:

* Flow variables—those whose values are available only to jobs, job arrays,
subflows or events within the current flow. These variables are set in
JS_FLOW_VARIABLE_LIST or in a file specified by JS_FLOW_VARIABLE_FILE.
— Parent variables are local variables whose values are set at the parent flow

scope. If the current flow is the main flow, the variables are set at the main
flow scope. These variables are set in JS_PARENT_FLOW_VARIABLE_FILE.
You use the built-in variable JS_FLOW_SHORT_NAME when you need to use
the shortened version of the flow name to avoid a potential name conflict
issue when using JS_PARENT_FLOW_VARIABLE_FILE to set parent flow
variables. For more details, refer to Using Platform Process Manager.

* Global variables—those whose values are available to all the flows within the
Process Manager Server. These variables are set in J[S_GLOBAL_VARIABLE_LIST
or in a file specified by JS_GLOBAL_VARIABLE_FILE.
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User variables can also be used inside environment variables.

Important: When selecting names for user variables, take care not to use the JS_
prefix in your variable names. This prefix is reserved for system use.

Environment variables

You can submit a job that has environment variables that are used when the job
runs. Environment variables can contain user variables.

Scope of variables and variable override order

Variables of the same name specified at different scope levels may override one
another. Variables set at an inner subflow scope override those set at an outer
subflow scope. This variable override order also applies to default values of input
variables.

For example, consider the following flow and job scope levels:

MF
O O

* If the JO job sets a flow variable A=100, the variable is visible to the main flow
MF scope and all subflow scopes (including SF). Therefore, J1, ]2, and J3 will all
use A=100.

o If J1 sets A=50, J2 will use A=50 because the variable set at the MF_SF subflow
scope overrides the variable set at the main flow MF outer scope. However, J3
still uses A=100 because the value at the main flow MF scope is still A=100. ]2
uses A=50 even if JO sets A=100 after J1 sets A=50.

This variable override order also applies to default values of input variables. For
example,

* If main flow MF has an input variable IV with a default value of 200, and SF
does not have input variables, J0, J1, ]2, and J3 will all use IV=200.

¢ If subflow SF now has the same input variable IV with a default value of 20, JO
and J3 will use IV=200, while J1 and J2 will now use IV=20.

* If JO sets IV=30, it overrides the default value at the MF scope, but not at the
ME:SF subflow scope. Therefore, J1 and ]2 will use IV=20, while J3 will use
IV=30.

e If J1 sets IV=5, J2 will use IV=5, while ]3 still uses IV=30.

Similarly, if you trigger a flow with variables, the variables will only override the
default values at the main flow level, but not the default values at subflows.
However, if you specified no default values in the subflow, then the specified
values are also visible to the subflow.

The variables set by the job have similar scope to variables in any programming
language (C, for example). If the job sets the variable in
JS_FLOW_VARIABLE_LIST (or in the file specified by JS_.FLOW_VARIABLE_FILE)
within a subflow, the scope of the variable is limited to the jobs and events within
the subflow. This means that the variable is only visible to that subflow and is not
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visible to the main flow or any other subflows. If the same variable is overwritten
by another job within the subflow, the new value is used for all subsequent jobs or
events inside that subflow.

If the job sets variables in the file specified by
JS_PARENT_FLOW_VARIABLE_FILE within a subflow, the user variable is passed
to the parent flow.

Flow variable values override global variable values. Similarly, a value set within a
subflow overrides any value set at the flow level, only within the subflow itself.

Environment variables are set in the job definition and the job runs with the
variables that are set.

If you use ppmsetvar to set user variables and you use ppmsetvar multiple times,
the variables will be appended. For example, if you run the following, the end
result will be a=10, b=2, c=7, and d=100:

ppmsetvar -f a=1 b=2

ppmsetvar -f a=10 c=7
ppmsetvar -f d=100

If you use ppmsetvar in conjunction with other methods of setting user variables in
Process Manager, such as a variable file or job starter, note that the variable file can
override any variables set with ppmsetvar as it is read last.

Dynamic subflows
When specifying input variable values for dynamic subflows, the same rules apply

because the specified values are effectively treated as default values of the input
variables.

List of Process Manager built-in variables

Currently, Process Manager provides the following built-in variables:

Built-in variable

Description Usage

Yol

Index of a job array element. Specify the variable as follows when

you want to use its current value:
You use the built-in variable %I to

obtain the index of a job array file_name.%]I

element. You can use %I ion the Job .

Array Definition—Edit Job dialog, 1?0 not specify brace brackets and #
General tab, in the following fields: sign.

* Input file

* Output file

* Error file

%]

Job ID of a job array. Specify the variable as follows when

you want to use its current value:
You use the built-in variable %J to

obtain the job ID of a job array. You file_name.%]

can use %J on the Job Array

Definition—Edit Job dialog, General Do not specity # sign and brace
tab, in the following fields: brackets.

* Output file

¢ Error file
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Built-in variable

Description

Usage

JS_FLOW_ID

Unique ID number of a flow.

You use the built-in variable
JS_FLOW_ID when you need to use the
unique ID number of a flow.

Specify the variable as follows when
you want to use its current value:

#{JS_FLOW_ID}

JS_FLOW_NAME

You use the built-in variable
JS_FLOW_NAME when you need to use
the complete, unique name of a flow.
The flow name is returned in the
following format:

flow_ID:username:flowname

Specify the variable as follows when
you want to use its current value:

#{JS_FLOW_NAME}

JS_FLOW_FULL_NAME

You use the built-in user

variable JS_FLOW_FULL_NAME when
you need to use the long version of a
subflow name.

For example,

¢ For a subflow named
11:usrl:F1:SF1:SSF1, this variable
is set to 11:usrl:F1:SF1:SSF1.

¢ For a main flow named 11:usrl:F1,
this variable is set to 11:usrl:F1.

* For a flow array element named
11:usrl:F1:FA(1), this variable is
set to 11:usrl:F1:FA. Note that this
does not include the array index. If
you need to differentiate between
array elements, you must use the
JS_FLOW_INDEX built-in user
variable.

#{JS_FLOW_FULL_NAME}
#{JS_FLOW_FULL_NAME}

(#{JS_FLOW_INDEX})

52 Using Platform Process Manager



Built-in variable

Description

Usage

JS_FLOW_SHORT_NAME

Shortened version of the flow name
to avoid a potential name conflict
issue when using
JS_PARENT_FLOW_VARIABLE_FILE
to set parent flow variables.

For example, there are two dynamic
subflows (DSF1 and DSF2) in a main
flow (11:usrl:F1), that both refer to
the same target flow (TF). If the target
flow sets a parent flow variable
myvar, both dynamic subflows will
overwrite each other’s value of the
myvar variable.

To prevent this issue, for all subflows
and flow arrays in a triggered flow,
use the JS_FLOW_SHORT_NAME
variable to indicate the name of the
subflow.

For example,

¢ For a subflow named
11:usrl:F1:SF1:SSF1, this variable
is set to SSF1.

¢ For a main flow named 11:usrl:F1,

this variable is set to F1.

* For a flow array element named
11:usrl:F1:FA(1), this variable is
set to FA. Note that this does not
include the array index. If you
need to differentiate between array
elements, you must use the
JS_FLOW_INDEX built-in user
variable.

Set the parent flow variable to
variable_name_#{JS_FLOW_SHORT_NAME}
in the job.

For example, for the myvar variable
name, the DSF1 dynamic subflow will
set #{myvar_DSF1} and the DSF2
dynamic subflow will set
#{myvar_DSF2}.

This allows both dynamic subflows to
avoid variable name conflicts even
though both dynamic subflows use
the same target flow.

If you want to use an environment
variable (such as
myvar_$JS_FLOW_SHORT_NAME, you
must list JS_FLOW_SHORT_NAME as an
input variable for the flow or job).

JS_ITERATION_COUNTER

You use the built-in variable

Specify the variable as follows when

JS_ITERATION_COUNTER when you you want to use its current value:

have specified a rerun exception
handler for a flow or subflow, and
you need to know how many times
the flow or subflow has been rerun.
The first time the flow or subflow is
run, the value of

JS_ITERATION_COUNTER is 0. If the

flow or subflow is rerun, the counter
is incremented. For example, if the
value of JS_ITERATION_COUNTER
is 3, the flow or subflow has been
rerun three times—it is running for
the fourth time.

#{JS_ITERATION_COUNTER}
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Built-in variable Description Usage

JS_EVENT([n]_FILENAME You use the built-in variable Specify the variable as follows when
JS_EVENT[n]_FILENAME when you you want to use its current value:

need to use the name of the file that
triggered this particular flow. #{JS_EVENT[n] _FILENAME}

If a flow is triggered by multiple files, Where 7 is the position of the
multiple variables are created, each triggering event in the list of possible
with a different value for n. The value events.

of n is determined by the position of

the triggering event in the list of

possible flow-triggering events,

including all types of events.

Consider the following examples,
where a flow definition is submitted
with multiple events that can trigger
the flow.

Example: one event at a time:

In this example, myflow is triggered

to run under either of the following

conditions:

* At 5:00 p.m. on the first Thursday
of the month (a time event)

e If a file called payupdt arrives in
the tmp directory

Flow Attribute triggering events:
First_thursday_of_month@Sys, 17:0
"/tmp/payupdt” arrival

Trigger flow when any event is true
When the file /tmp/payupdt arrives,
the name and value of the built-in
variable are as follows:
JS_EVENT[2]_FILENAME=/tmp/
payupdt

If the flow is triggered by the time

event, no value is set for
JS_EVENT[2]_FILENAME.

Note that the value of n in the
name of the variable corresponds to
the position of the file event in the
list of events.
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Built-in variable Description Usage

Example: multiple events

In this example, myflow is triggered

to run when all of the following are

met:

e A file called payupdt arrives in the
tmp directory

* Today is Wednesday

* The file /tmp/dbupdt exists
Flow Attribute triggering events:
"/tmp/payupdt" arrival
Wednesdays@Sys, 0:0
"/tmp/dbupdt" exist
In this example, all of the
conditions must be met before the
flow is triggered. When the flow
triggers, the names and values of
the built-in variables are as follows:
JS_EVENT[1]_FILENAME=/tmp/
payupdt
JS_EVENT[3] _FILENAME=/tmp/dbupdt
Note that the value of n in the
name of the variable corresponds to
the position of the file event in the
list of events.

JS_EVENT_n_FILENAME_BASE Base file name, part of Specify the variable as follows when
JS_EVENT[n]_FILENAME. you want to use its current value:

#{JS_EVENT _n_FILENAME_BASE}

Where you can use variables

You can use a variable in the following places in the Flow Editor:

* On the Job/Job Array Definition—Edit Job dialogs, General tab, in the following
fields:

— Name—applies only to jobs, not job arrays
Note:

If you used a user variable to describe the job name, and your job is not in a
flow array, you must ensure that your flow is arranged such that the user
variable is resolved before triggering the flow.

This is because if the user variable is not resolved when the flow is triggered,
the flow will fail to be triggered unless the job is in a flow array. Once the job
name is resolved with the user variable, the job name will not change later
even if the value of the user variable changes.

— Command to run

— Index expression—applies only to job arrays
— Project name

— Input file
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— Output file
Error file

Email address

Run as user name

* On the Job/Job Array Definition—Edit Job dialogs, Submit tab, in the following
fields:

— Queue name
— Application profile name
— Service level agreement name
¢ On the Job Definition—Edit Job dialog, Processing tab, in the following fields:
— Host Requirements
- Run on hosts
— Number of Processors for Parallel Jobs
- Minimum
- Maximum
- User Priority
* Priority
- User Group
* Associate job with user group
- Before Execution
*  Run command
* On the Job Definition - Edit Job dialog, Limits tab, in the following fields:
Limits tab
— Host Limits
- Maximum CPU time
- Maximum run time
— Job Limits
- Maximum file size
- Maximum core file size
- Maximum memory size
- Maximum data size
- Maximum stack size
* On the Job Definition—Edit Job dialog, Resources tab, in the following field:
Expression
* On the Job Definition—Edit Job dialog, File Transfer tab, in the following fields:

Local path including name

File on execution host
* On the File Event Definition dialog, in the following field:
— File name
* On the Manual Job Definition dialog, in the following field:
— Message
* On the Alarm Definition dialog, in the following field:
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— Description
* On the Flow Attribute dialog, in the following field:
— Email address

Include the variable evaluator to run jobs based on decision
branches
About this task

The variable evaluator (VE) is a work item in the flow editor that allows jobs to
depend on the evaluation of variable expressions instead of the traditional job exit
status, time events, and file events. This work item contains no actual jobs to run,
and therefore you cannot kill, suspend, or resume it. In addition, since the work
item does not perform any actual work, you cannot use the variable evaluator as a
triggering event, a proxy event to start the next work item, or as a flow completion
criterion.

The variable evaluator serves as an intermediate step between jobs and the
validation of variable decision branches. Typically, the predecessors of a variable
evaluator assign values to various user variables. When all the variables are set,
the variable evaluator will evaluate all of its variable expression branches and
determine which successors to start executing. If there is no predecessor to the
variable evaluator, the variable evaluator will start and run to completion
immediately.

When you specify the variable expressions for each branch, you can use a
combination of variables, operators, and constants. The variable evaluator supports
the following operators: <, >, =, >=, <=, =

The basic variable expression consists of one variable, one operator, and one
constant: variable operator constant. For example, #{A} > 1.

You can also create larger and more complect expressions by joining smaller
expressions using the following boolean operators:

8% (AND), || (OR), ! (NOT), () (parentheses). However, you can only apply
! (NOT) to variable expressions and not to literals. That is, ! ({#A} > {#B}) is valid
while ! ({#A}) >{#B} is not.

For example, the following at all valid combinations of variable expressions:
#{A} < 4 && #{B} > 3
LAY < 4[] #(B) > 4)
L(#{A} > 2 && #{B} > 3) || #{C} > 5

You can also specify an else branch decision. The variable evaluator only evaluates
else branches to TRUE if all other non-else branches evaluate to FALSE.

Display or hide variable evaluator expressions by selecting View > Show
Dependency Conditions. You can also access the menu from the pop-up menu by
right-clicking in the flow canvas.

Procedure

1. Click the Variable Evaluator button to put the Flow Editor in variable
evaluator placement mode.
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2. Left-click in the workspace in the location where you want to insert the
variable evaluator.

The variable evaluator icon is added to the flow diagram.

3. If you want to include a name or description of the variable evaluator,
double-click the variable evaluator icon that you added and specify these fields.

4. Draw the lines linking any predecessors (dependencies) the variable evaluator
has on other work items in the flow definition.

The predecessors will likely have variable definitions on which the variable
evaluator will make decisions.

If you do not define any dependencies for the variable evaluator, the variable
evaluator will be triggered immediately when the flow runs.

5. Draw the lines linking the variable evaluator to the decision branching jobs that
depend on the variable evaluator.

In the flow editor, the decision branching can be drawn as a link object from
the variable evaluator to any successive jobs. The link dependencies definition
has the following options:

* Specify a variable expression

The variable evaluator branches to this job if the variable expression that you
specify is TRUE. Specify a variable expression or a combination of variable
expressions.

If you specify multiple branches that evaluate to TRUE in a workflow, they
will all run their next jobs.

Note:

If, at runtime, a variable is undefined and thus cannot be resolved to a value,
the variable evaluator evaluates the corresponding sub-expression to FALSE;
however, the whole expression might not be evaluated to FALSE.

* else

The variable evaluator branches to this job if all the other variable
expressions are FALSE.

If you specified multiple else statements in a workflow, they will all run their
next jobs if the all of the other (non-else) variable expressions are FALSE.

6. Click OK.

Use global variables
Procedure

In the Flow Manager, from the View menu, select Global Variables. The list of
global variables and their values is displayed.

Add a global variable
Procedure

1. In the Flow Manager, from the View menu, select Global Variables.

2. Click Add in the Global Variables window. The Add Variable window is
displayed.

3. In the Name field, specify a unique variable name. You can use alphabetic
characters, numerals 0 to 9, space, and underscore (_) in the variable name.

Note:
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Name cannot start with a numeric character.
4. Set a value to the variable.

Note:

Do not include equal or semicolon characters in the value.

5. Click OK to add the global variable. The added variable can be referenced in a
flow instance.

Remove a global variable
Procedure

1. In the Flow Manager, from the View menu, select Global Variables.
2. Select a variable and click Remove in the Global Variables window.

Edit a global variable
Procedure

1. In the Flow Manager, from the View menu, select Global Variables.

2. Click Edit in the Global Variables window. The Edit Variable window is
displayed.
3. Set another value to the existing variable.

Note:

Do not include equal or semicolon characters in the value.

4. Click OK. The edited variable can be referenced in a flow instance.

Setting user variables within a flow definition

When defining a job that sets one or more variables, ensure that you specify a
queue that is configured to support user variables.

Tip:

Before you can set or use user variables in a flow, your Process Manager system
needs to have one or more queues configured to accept them. Check with your
Process Manager administrator to see which queues are configured to support
variables.

Types of user variables you can set

There are two types of variables you can set:

* Flow variables—those whose values are available only to jobs, job arrays,
subflows or events within the current flow

* Global variables—those whose values are available to all the flows within the
Process Manager Server

Methods to set user variables

User variables are set using the following methods:
* Job starter.

This method is still supported for backwards compatibility but is deprecated.
Use ppmsetvar instead.

e External file.
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This method requires a shared filesystem. The jfd work directory must be on a
shared filesystem accessible by all your jobs.

Process Manager can set user variables by writing to an external file.
— On UNIX, by setting the value within a script
— On Windows, by setting the value within a bat file
* The command ppm